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Lucity GIS Viewer

In this session, we’ll introduce you to the Lucity GIS Viewer
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Data Sources
Two types of data sources can be used with the Lucity GIS Viewer: local and online.

Local

Local data can be used by the GIS Viewer in the form of packages. Packages are a set of items (maps
and referenced data) that ArcGIS bundles into a single file. Packages are created using the ArcGIS
Desktop software and can be easily transferred from user to user or easily provisioned onto a machine.

The GIS Viewer can consume Map, Title, and Locator packages. The following is a description of each:

File

Package name . Description
< extension .

Map package  MPK Map packages (.mpk) make it easy to share complete map documents with others. A map package contains a map document (.mxd) and the data
referenced by the layers it contains, packaged into one convenient, portable file. Map packages can be used for easy sharing of maps between colleagues
in a work group, across departments in an organization, or with any other ArcGIS users via ArcGIS Online., Map packages have other uses, too, such as the
ability to create an archive of a particular map that contains a snapshot of the current state of the data used in the map.

Tile package  TPK Tile packages (.tpk) contain complete cached map documents in the form of 2 map and a tile cache of the data. Tile packages can be used for easy sharing
of cached maps between colleagues in a work group, accross departments in an organization, or with any other arcGIS user via ArcGIS online. Tile
packages are ideal in disconnected environments where you still need access to the data.

Locator GCPK Locator packages (.gcpk) make it easy to share locators with others. A locator package may contain one locator or a composite locator along with its

package participating locators packaged into one convenient, portable file. The file size of the locator package is smaller than the locator as it is compressed and

thus makes file transfer easier. Locator packages can be used for easy sharing of locators between colleagues in a work group, across departments in an
organization, or with any other ArcGIS users via ArcGIS online. Locator packages can also be used to create an archive of the locators.

Online

In addition to packages, the Lucity GIS Viewer can also consume online data sources. These are
geospatial web services (such as map services and geocoding services) created and distributed by
ArcGlS for Server.

Notes:
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Map FPackages

Map packages (.mpk) make it easy to share complete map documents with others. A map package
contains a map document (.mxd) and the data referenced by the layers it contains, packaged into one
convenient, portable file. Map packages can be used for easy sharing of maps between colleagues in a
work group, across departments in an organization, or with any other ArcGIS users via ArcGIS Online.
Map packages have other uses too, such as the ability to create an archive of a particular map that
contains a snapshot of the current state of the data used in the map.

Creating a map package

1. Prepare an ArcMap map document with the data and settings (symbology, scale dependent
rendering, aliases, etc) you would like to deploy in the map package.

2. In ArcMap, click Customize > ArcMap Options on the main menu. The ArcMap Options dialog
appears.

On the Sharing tab, under the Packaging Section, check the Enable ArcGIS Runtime Tools.
4. Click OK.

ArcMap Options v —_— ||
| Genersl | DataView | LoyoutView | Metadata | Tables | Raster |
CAD Sharing Display Cache

Pubiishing

Lets you change the location where your map will be staged when

publishing to ArcGIS Server. You can override this folder from an ArcGIS
Server Connection in Catalog.

Use Default
Show warning when cache exceeds 500.0 MB

Show file location when saving draft service definitions
Packaging
Lets you choose to support the ArcGIS Runtime when packaging.
Enable ArcGIS Runtime Tools

Lets you choose the location to unpack packages for all ArcGIS Desktop
applications.

@ Automatically select location

() Use user specified location

5. Click File > Share As > Map Package on the main menu. The Map Package dialog box will

display.
File | Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
0 New.. Cerl+N b - | 1:10,600 - BB
E% Open.. Ctrl+0 [ a ‘)( S g e
=
d Save CubeS [ Disable Lucity Editor Alias Import
Save As...
o x
Save A Copy...
| Share As » ||@ Map Package... " |_|TI'ITITITI'I'I'H'I m
Add Data » EE Tile Package... I 1
. Map P.
Eg SignIn... @ Service... ap Package
Create a map package containin
oo PP 9 9
0o ArcGES Online... this map and zll the data it
Page and Print Setup... references zipped up into one
X X convenient file, and either upload
ER Print Preview... it to ArcGIS Online or save it to
& Print... disk.
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6. In the Map Package dialog, fill out the required information. The critical item is to make sure
the Support ArcGIS Runtime is checked.
e T ol I A ]

 Prohze [ Share (~)

niace Map Package
Item Description
Additional Files (©) Upload package to my ArcGIS Online account
BaseMap
@) Save package to fle
Q:\Groupledaniel RuntimePackages BaseMap. mpk &)
Indude Enterprise Geodatabase data instead of referendng the data
Support ArcGIS Runtime
Reference all data 1

About creating a map package

Note: You have the option to reference SDE data or to include it in the map package. Keep
in mind if you choose to include the data, any changes to the underlying SDE data will not be
visible in the Lucity GIS Viewer until the map package is recreated.

7. Click Analyze to validate your map for any errors or issues.

8. Once validated, click Share to create your map package.

For more information on creating map packages refer to ESRI’s help at:
http://resources.arcgis.com/en/help/main/10.1/index.html#//006600000403000000
And

http://resources.arcgis.com/en/help/runtime-
wpf/concepts/index.html#/About_map_packages/017000000059000000/

Notes:
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[ile Packages

A tile package allows you to create a set of tiles (images) from a map, and then use the set of tiles as a
basemap in ArcGIS applications. The tiles are wrapped into a single file, a .tpk file, so you can share
the file as you would any file. You can email it, copy it to a network locale, upload it to ArcGIS Online,
and so on.

Creating a tile package

1. Prepare an ArcMap map document with the data and settings (symbology, scale dependent
rendering, aliases, etc) you would like to deploy in the tile package.

2. In ArcMap, click Customize > ArcMap Options on the main menu. The ArcMap Options dialog
appears.

On the Sharing tab, under the Packaging Section, check the Enable ArcGIS Runtime Tools.
4. Click OK.

ArcMap Options < B |
| Genersl | DataView | LoyoutView | Metadata | Tables | Raster |
CAD Sharing Display Cache

Publishing

Lets you change the location where your map will be staged when
publishing to ArcGIS Server. You can override this folder from an ArcGIS
Server Connection in Catalog.

Staging Path:
(]
Use Default
Show warning when cache exceeds 500.0 MB

Show file location when saving draft service definitions
Packaging
Lets you choose to support the ArcGIS Runtime when packaging.
Enable ArcGIS Runtime Tools

Lets you choose the location to unpack packages for all ArcGIS Desktop
applications.

@ Automatically select location

() Use user specified location

e

5. Click File > Share As > Tile Package on the main menu. The Tile Package dialog box will

display.
File | Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
[ New.. CtilsN | . [ 1114775 - GEBES
E- Open... Ctrl+0 s~ P a /( &+ g Asset Type:
@ sae =S p ] Disable Lucity Editor Alias Import -
Save As..
nx
Save A Copy..
| Share As 4 ’El Map Package...
Add Data v | EHE Tile Package...
Bg Sign In... @ Service... — -
— . Tile Package
oo ArcGIS Online...

3 - Create a tile package from the
Page and Print Setup... current map zipped up into one
@ Print Preview... convenient file, and either upload
= . it to ArcGIS Online or save it to
i Print... disk. A tile package contains a

cache of tiles that you can use as a
Er s basemap in ArcGIS Runtime
Analyze Map... applications.
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6. In the Tile Package dialog, fill out the required information.

i -— 5

o Analyze fiShare (A)

Tile Package

Tile Format.

Item Description

Tile Format
Tiing Scheme:

Tile Format:

Approximate Cache Size:

[Arc1S Oniine / Bing Maps / Google Maps

PNG -

6Mb

| Levels of Detal

Choose the number of levels to create for this tie package. Alllevels up to and induding the

selected level wil be generated.
=

Building

l Highest Level of Detail: 200f 20

Level: 13

Scale: 1:1,128.49

Note: If you use the ArcGIS Online/Bing Maps/Google Maps tiling scheme, the data
frame of vyour source map document must use the WGS 1984 Web Mercator
(Auxiliary Sphere) projected coordinate system.

7. Click Analyze to validate your package for any errors or issues.

8. Once validated, click Share to create your tile package.

For more information on creating tile packages refer to ESRI’s help at:
http://resources.arcgis.com/en/help/main/10.1/index.html#//006600000457000000
And

http://resources.arcgis.com/en/help/runtime-
wpf/concepts/index.html#/About_tile_packages/01700000004w000000/

Notes:
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locator Packages

A geocode locator package (.gcpk) makes it easy to share locators with others. A locator package can
contain one locator or a composite locator along with its participating locators packaged into one
convenient, portable file. The file size of the locator package is smaller than the locator, as it is
compressed and thus makes file transfer easier. Locator packages can be used for easy sharing of
locators between colleagues in a work group, across departments in an organization, or with any other
ArcGIS users via ArcGIS Online. Locator packages can also be used to create an archive of the locators.

Creating a locator package
1. Create a locator or composite locator in ArcCatalog.

2. In ArcCatalog, right-click on a locator or = Qgcasle
composite locator and click Share As > @‘Lucmm B Copy CubeC
Locator Package. The Locator Package 25 v % e
dialog box appears. e P

T LucityGIS7) Privileges...

E2) LucityGIS]
% L:::gGI ;‘ Share As 4 H@ Locator Package... "
|

3 LucityGIST| [ Properties... &  Geocode Sewvice...

27 LucityGIS750.DBU-Cueity TRAFFIC { Share as Locator Package
121 LucityGIS750.0BO.LucityWATER
27 LucityGI5750.0BO.LucityWATERDIST

Share this locator as a package.

3. In the Locator Package dialog, fill out the required information.
=)

Locator Package

 Bnalyze  { Share (A)

laaigbadany Locator Package

Item Description
Additional Files @ STNETG_AddressLocator

(©) Upload package to my ArcGIS Online account

STNETG_AddressLocator

@ Save package to file

Q:\Group\edaniel\RuntimePackages\STNETG _AddressLocator .gcph

[7] Indlude locators in Enterprise Geodatsbase instead of referencing them

Note: You have the option to reference SDE data or to include it in the locator
package. Keep in mind if you choose to include the data, any changes to the
underlying SDE locator will not be visible in the Lucity GIS Viewer until the locator
package is recreated.

4. Click Analyze to validate your locator for any errors or issues.

5. Once validated, click Share to create your locator package.

For more information on creating tile packages refer to ESRI’s help at:
http://resources.arcgis.com/en/help/main/10.1/index.html#//00250000003v000000
And

http://resources.arcgis.com/en/help/runtime-
wpf/concepts/index.html#/About_locator_packages/01700000005s000000/
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Lucity GIS Viewer Setup

The Lucity GIS Viewer is configured to use map settings setup in the Lucity Administration application.
This section describes the various settings that must be configured before using the Lucity GIS Viewer.

e Lucity Administration Tool
o Map Services
o Map Setup
o System Settings

o Authorizations

ArcCatalog

o Geodatabase Configuration

Lucity Desktop

o Show in Map Configuration

Lucity Security
o User Permissions

Workstation Installations

Notes:
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Lucity Administration Too/

The Lucity Administration tool is used to configure the majority of the settings necessary for the GIS
Viewer to run. This section will cover each component in detail

To access the Lucity Administration tool go to Start>>All Programs>>Lucity>>Lucity Administration tools
or run the Lucity.Admin.exe located in the local ...\Lucity\bin directory.

Map Services

Map services indicate the data that will be loaded into Lucity GIS Viewer. This is where you would
specify your local and/or online data sources.

1.

Lucity GIS Viewer Overview (2015 and 2015r2)

In Lucity Admin click GIS>>Map Services... The GIS Map Services dialog will appear.

Security  Windows  Help
GIS Config...

Connection 5trings...

GIS Map Services |E=n|E=n =
Has  Dissble Mabie
Name U Oder  Opacity 5‘5;,7 Tied? Festure  Local E:r‘"?, UserName Password '6%%°  Fedtwe Y LastModfied! LasiModfiedD: LadtModfiedTime
Service? Caching Service
ud
[ L.t;GI3Dev_Allayers hitp:/Act-arcsrv-Dt LucityGISDev_f 2 o8| 8 a ] edaniel 7252014 [8:32AM
LuciyGlSDev_GISTasks i/ LucityGISDev_GIS 4 ] a ] edaniel 812014 [257PM
LuctyGlSDev_Redining hitp:/Act-arcsry LucityGISDev_} 4 o/ g, 8 a ] edaniel 812014 [257PM
LuciyGISDev_Parcel i/ LucityGI$Dev_f 1 oo 8 [} ] edaniel /B0 | BRAM
LuciyGISDev,_S http. LuciyGISDev_ 3 [SRNE] [S] [&] edaniel 7/25/2014 | 832 AM
LuciyGISDev,_S http. LuciyGISDev_ 2 [SRNE] [§] [S] [&] edaniel 7/25/2014 | 832 AM
LuciyGISDev_Park http. LuciyGISDev_| 2 [SRNE] [5] [S] [&] edaniel 7/25/2014 832 AM
LucyGISDev_lmagery http. LucityGISDev_| 0 [SRNE] [&] [&] = edaniel 8/1/2014 257PM
EsiTopo IUSA_Topo_Maps/Map! 0 [SRNE] [&] [&] = edaniel 7/25/2014 | 11:33AM
LiveOpenWorkOrde hitp: LucityGISDev_LiveWorkLaysrs/MapServer [SRNE] [&] [] [i&] edaniel 7/25/2014 | 11:28 AW

Click the Add Map Service button at the bottom. This will add a new record to the table. Fill
out the following information:

e Name- This is a unique name for the map service. This can be whatever you’d like and
will be used later when indicating what services should be associated with the map

e Url- This is used by the map to display data.

o For local data sources you would specify the path (including filename) of the map or
tile package. For example, Q:\Group\edaniel\RuntimePackages\BaseMap.mxd. In
addition, if the package is located on a network share, it is strongly recommended that
UNC be used instead of a mapped drive to prevent issues caused by missing or incorrect
mapped drives on end user machines.

o For online data sources this is the URL to the map service. For example:
http://services.arcgisonline.com/ArcGIS/rest/services/World_Street_Map/MapServer.
Note: The URL must be a REST service.

e Order- This is the order in which the map service should appear when overlaid with other
map services. Lower order numbers will appear underneath map service with higher order
numbers.


http://services.arcgisonline.com/ArcGIS/rest/services/World_Street_Map/MapServer

e Opacity- This is the default opacity that will be used when the service is loaded in the
map

e Tiled- Place a check in this field to indicate a tiled package or web service.

o Disable Local Caching- Default is false. If you were to disable local caching requests to
refresh the map image will go directly to ArcGIS Server rather than the browser’s cache.

3. Click Save

Map Setup

Once packages and/or web services have been added to the Map Services section of the Lucity Admin
tool you can use the Map Setup section to start creating the maps.

1. In Lucity Admin click GIS>>Map Setup... The GIS Map Setup dialog will appear.

GIS | Security Windows H

GI5 Config...

Connection Strings...

Map Services...
I Map Setup... I

Maps Group Assignment for [GISDev]
Shared Web Only Available Groups Groups assigned to this map

o Admiristrator
AdminRoles-Dee @ Assign Group(s) to
Map >>

Dashboard Users

Dee LowPemms
Dee T5 Full Admin Un-Assign Group to
EquipmentReadOnly Map <<

GIS Administrator

Default web map for group [Administratar]. ‘Set this map as web default for group
GlSDev I or]

Default mobile map for group [Administrator]: Set this map as mobile defauit for group
GlSDev [Administrator]

System Default Bxtent

This extent is used to limit geocoding search results and s also a factor when
Add Map Setup determining the default extent for web and mobile maps.

Current extent:

—
Enter url to service or layer to calculate an extent:

Delete M
T
Save Manually Enter
Help Format: (¥min, Ymin Xmax, Yman whid)

Notes:
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2. The left-hand side of the dialog displays all available maps. Click the Add Map Setup or Edit
Map Setup buttons to open the GIS Map Edit screen.

I Name. Lucty application(s) that can use thismap:  Web & Mobile -

Geocoding

Defauit Geocoding Ut ‘http //geocode arcg i |

Geocoding U i
differert than defaul)

Rediring
‘Seloc the feature svics tht containg the rediring Enterthe feature layer index for the three redining layers:
LucityGISDev_SecureRedining - Fointindex: 0 Polyiine index: 1 Polygonindex: 2

Senvices to Display in Map

Order  Disable
Order  (Gveride  Identiy

Disable Disable Defautt
Edis  Vishiity Bdent
Parcels —

LucityGISDev_SewerStreet Storm LucityGlSDev_Imagery
LucityGISDev_ParksSecured

LuciyGISDev_WaterSharedOnAGOL LucityGISDev_Parcels hitp:/Act-arcsrv-01
DemoLucity_Rasterimage LuctyGISDev hitp:/k

LuctyGISDev_ Hitp:/A

Add >>

Available Editable Services

LucityGlSDev_Allayers
LuctyGISDev_Edtable Tasks
LucityGISDev_WaterHostedOnAGOL

'

Avalable Local Services

4
3. Enter a unique map Name. Each map setup has to be assigned a name. If you setup more than
one map then a user will be given a list of map names to choose from.

4. Select GIS Viewer from the Lucity application(s) that can use this map list box. This setting
must be set to GIS Viewer!

5. Set the Geocoding URL. Enter a URL here if the geocoding service used for this map will be
different that the URL in the Default Geocoding Url box. The Default Url is set in Lucity
Administration under System > Settings on the GIS tab. Note: The GIS Viewer will work
with either an online geocoding service or a local locator package. To use a local package
enter the file path including name of the package. For example:
(Q:\Group\edaniel\RuntimePackages\STNETG_AddressLocator.gcpk).

6. In the Available Web Services grid, select all the web services that need to be added to the
map and click Add. Records will appear in the Services to Display in Map grid.

7. In the Available Local Services grid, select all the web services that need to be added to the
map and click Add. Records will appear in the Services to Display in Map grid.

8. In the Services to Display in Map grid check the Disable Identify box to stop the identify tool
from querying that service. Disabling Identify also disables the ability to select features in that
service. Note: Users can also manually control selectability in the map.

e The order cannot be customized in this dialog; instead, set the order in the Order field
under GIS > Map Services.

9. Click Close to return to the Map Setup screen.

Lucity GIS Viewer Overview (2015 and 2015r2) 11



System Settings

Additional settings can be configured for the Lucity GIS Viewer. These settings are set Lucity Admin
tool.

1. In Lucity Admin click System>>Settings... The System Settings dialog will appear.
£ Lucity Administration 750 - Client: CLINTOLS - User: EDANIEL T

System | Dashboard Navigaion Forms Reports GIS  Security Windows  Help

| Settings...
Mansge Web Site Caches..
Mansge Public Web Site Caches..
Object Lack Mansger...

User License Manager..
Active User Manager..
Activations Manager...
Bt

GIS Desktop I GIS Edit Integration I GIS Routing | GIS Web | Mobile | REST API I Settings with custom inteface | TimeSheet I ‘Web Peformance | Web Site I Work |

Description Walue
» Automatically save redlining edits FALSE
Comma separated criteria to use for a where clause f parcel layeris to be queried. Keywor... | ADG_ADR_BDG={BUILDING} ADDRESS=":{STREETNAME}%'
Default Base Map Name

Default extent for Mercator basemaps xmin ymin xmax ymax
Force the GIS Web Map to always open to the default extent TRUE

Gperaiond Do Spoel ceence WHID

Schema name where the LiveData geodatabase repository is loaded

Separator to use for Geocoding Intersections |
treet Address Geocoding Field Street

URL for Geocoding Service or URL to parcel layer in map service http.//dema Jucity net/arcgis./rest/services/Geo Locate /Geocode Server

2. Make changes, as needed, to the following settings.

e Operational Data Spatial Reference WKID- The WKID is the "Well Known Spatial ID" for the
operational data layer in the Webmap. This spatial reference will be used by Lucity to
record xy coordinates and any other spatial data.

e Street Address Geocoding Field- If using an online geocoding service then this is the field
name the geocoder is based on.

e URL for Geocoding Service or URL to parcel layer in map service- (Optional) The URL for
the geocoding or parcel services for finding addresses. To switch between the two check
the setting "Use an address layer for ..." Note: REST/ must precede the word service in
the URL.

e Use GIS Viewer instead of GIS Web for Show in Map- Forces the Lucity Web show in map to
launch the Lucity GIS Viewer instead of the Lucity Web Map.

Notes:
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Authorizations

The Lucity GIS Viewer is licensed on a per machine basis. Therefore, in order for a user to be able to

run the GIS Viewer, their machine has to be activated to use the GIS Viewer.

The first time a user attempts to run the Lucity GIS Viewer the application which check if the machine

has been activated, if not, they will receive a prompt confirming they want to activate the machine.

You may find the need to deactivate a machine. The Activations Manager in Lucity Admin offers the
ability to view the systems current activations and allows you to deactivate licenses.

1.

In Lucity Admin click System>>Activations Manager... The Activations Manager dialog will
appear.

Security  Windows  Help

Systern | Dashboard  Navigation

Forms

Settings...
Manage Web Site Caches...

i Manage Public Web Site Caches...

Object Lock Manager...
User License Manager...

Active User Manager...

[ Activations Manager...

Exit

Reports  GIS

ERICDANIEL-LT

nrjeKErde
MUMtRESTTest | wzu7RFzeTo

User Name

edaniel

8/7/2012 3:53:29 PM

Luity

81472012 5:11:43 AM

GISESRIRurtime
WoreOrders Android

MUnitLogonTest1 | FaWtl352Ag

MUnit

8/13/2012 3:50:33 PM

FakeSiteForlnit Testing

MUnitLogonTest? |@a0ukPemvi | NUnit

81372012 9:50:33 PM

FakeSiteForlnit Testing

MUnitLicenseTest | nVuomt2ot9 | NUnitLicenseTest | 8/13/2012 9:56:03 PM | WordOrders Android
act_test tdtpeucLk | Lucity 8142012 5:11:13 AM | WorkOrders Android
deact_test VwleSh3wRw | Lucity 81472012 5:11:15 AM | WorkOrders Android

[ Deactivatelicense | [ Viewlog | [ Send Email With Code |

2. The Name column lists the device (computer) name. The License column lists the product that

3. To deactivate a license, simply select the device to deactivate and click the Deactivate

Notes:

has been activated. Note: Lucity GIS Viewer license is named “GISESRIRuntime”

license button.

Lucity GIS Viewer Overview (2015 and 2015r2)
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ArcCatalog

Lucity’s Geodatabase Configuration tool in ArcCatalog can be used to validate your geodatabase
configuration to ensure that it is properly setup in order for the Lucity GIS Viewer to work with your
data.

Geodatabase Configuration Tool
Note: Users must have the following Lucity Security permissions to use this tool

e GIS > GIS System Configuration > Run
e GIS > GIS Admin Connection Strings > Edit

1. In ArcCatalog, Click on Lucity GIS Tools>>Geodatabase Configuration.

Lucity GIS Tools +| _

| Geodatabase Configuration |
Show In M S
Default Fi Lucity Geodatabase Configuration

Update G Configures t|':IE intergration
between Lucity and your
Update Sh  geodatabase(s)

QA/QC T

2. Right-Click on the geodatabase node and select Validate

SF Geodatabase Canfiguration for, Lucity

=

Add Feature Class
Delete Multiple Feature Classes
| Validate Workspace
Set "Update Lengthjarea” Flag to True

Darnains 3

¢ Immediately upon clicking this tool, a dialog similar to the one shown below will be
displayed with results of the verification. Once it is complete you will be able to scroll
down and view any messages resulting from verification.

r -
Validation Results (BN
File -

Validating Setup Requirements B
General Custom CMGENINVG —
Solid Waste CMSWASTEG
Facilty Buildings EFBLDGG
Facilty Door EFDOORG
Equipment EFEQUIPG
Fleet EFFLEETG
Facility Floor EFFLOORG
Facility Fumishing EFFURNG
Facilty Roof EFROOFINVG
Facilty Room EFROOMSG
Facilty Ste Asset EFSASSETG

e Warnings to watch for are “Missing Alias Name!”. Alias names must be assigned to the
feature classes that are used with the Lucity GIS Viewer.

e Refer to the Help Guide on how to assign alias names to your feature classes; there are
Lucity GIS tools in both ArcCatalog and ArcMap that assist in this process.

Lucity GIS Viewer Overview (2015 and 2015r2)
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Lucity Desktop

There are settings in the desktop application that must be configured in order for it to open the Lucity
GIS Viewer when using the show in map capabilities.

Show in Map Configuration

1. In the Lucity desktop application, click on System>>Configuration>>GIS>>Show In Map... The
Show in Map Configuration dialog will appear

Lucity 7.5 - Master SQL Server Deve |OFMEH

System | General Sewer Storm Transportation Water Electric Gas Trees/Parks Equipment Facility
Configuration 4 Program Options...
Change Client ActiveX/OCK Controls..,
GIS 4 Database...
GI5 Toolkit Show In Map...
Exit Alt+Fd Address Show In Map...
s - Show In Map Conﬁgm =)
Echap Praject for Display l— - I
|F no project 15 specihed. the defaull web map far this user wil be opened.
o T Map

Companent |T:\TeleateslBulld\FlogramsNU\bm\Luclw.E\SVlw ... I

al

Parameters: /Client Number  /GeoDatabase Table Name
fGeoDatabase |D Field Mame  AAsset D

I~ Include comma delimited lists of all possible feature classes

[/ Componet

Cumpunenll Lucily. Showlnap. exe
Paiameters [scomd  [yooord

[ work Order Camponent

Componentf {1 ucity ShowlrMap. exe

Parameters |WD,ID

~Add toa Work Order Component
| Eomnonen1 Lucity. Showlnhap exe

Pararmeters |WD_ID I

oYy

r—Add %47 to Work Order Component
| Eomponenll Lucity. Showlnhd ap.exe I
Parameters [wO_ID
Change to Default | oK | Cancel |

2. Make the following changes to configure the desktop to work with the GIS Viewer:

e ArcMap Project for Display-This must be blank, if there is a current value in this field clear
it out.

e Components- All the components should be pointing to the local
\Lucity\bin\Lucity.GISViewer.exe. If not, click the ... button to specify the
Lucity.GISViewer.exe.

Lucity GIS Viewer Overview (2015 and 2015r2) 15



Lucity Security

In order for users to access the Lucity GIS Viewer, they must be given the proper permission in the

Lucity Security program.

In the Lucity Security program make sure all users that will be using the Lucity GIS Viewer application

have been assigned the Run permission for GIS Viewer, this permission is listed under the GIS node.

Groups:

Equipment ReadOnly
GIS Administrator
GIS User

Jonathan Test
MoAccess Security
MNoels Security Test
NoelsTest
PublicWebGroup
RESTAPIGroup

test

Victoria's Test Group
WebAppPemissions Testing
WorkOrderReadOnly

Workstation Install

Users In Groupls):

Assigned Pemissions

afowles

BP
bvandusen
Chris

Dale
Deaun
Don Pinkston
edariel
Frank
Geoff
gtomes
jiohanson
jlenight

Joe
jsemones
jswain
Lindsey
Irich

»

m

)

-

i O B

-

Admin
Hlectric
Equip
General

- = Admin Connection Strings
- == Admin Map Services

#-- 0= Admin Map Setup

(= (G5 System Corfiguration
- GIS Viewer I

== GIS Web Map

T | imir (31€

»

m

Modules View | Permissions View

Modules

-] Admin
(-] Blectric
[T Equip
--DGenemI
= GIs
-..[”| Admin Connection Strings
-] Admin Map Services
[] Admin Map Setup

GIS System Configuration
GIS Viewer

|| GIS Web Map

[ Lucity GIS

[T Work Order

[T Work Request
R

The Lucity GIS Viewer application is licensed on a per machine basis, thus it should only be installed on

the number of machines that you own licenses for. The standard Lucity Workstation install does not

install the GIS Viewer application nor does the option to install Admin Tools.

In order to install the Lucity GIS Viewer on a machine, you must select the Custom install option with
the Lucity workstation installation

Notes:

Lucity GIS Viewer Overview (2015 and 2015r2)
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Lucity GIS Viewer Overview

The Lucity GIS Viewer is a standalone mapping application that allows users to interact with their asset
data. It doesn’t require any ESRI software to be installed on their machine and can be easily deployed
to end users. The Lucity GIS Viewer is made up of a map display, two toolbars, and a navigation wheel.

Launching the GIS Viewer

e From the Start Menu
Once the Lucity GIS Viewer has been installed on a machine, it can be started by the

(e}
shortcut in the operating system’s start menu.

e Directly from the .exe
Once the Lucity GIS Viewer has been installed, it will be located in the local \Lucity\bin

(e}
directory. You can launch the application by double-clicking the Lucity.GISViewer.exe.

e From the Show in Map button

Once the web and desktop application has been configured to use the Lucity GIS
Viewer, then you can launch the application by clicking the various show in map

buttons within the desktop and web applications.

@)

GIS Viewer [ools

e Map Management Tools

In the top left corner are the map management tools. They allow users to view
information about the map, control selectability and visibility, open and close the data

table, add data, and perform standard map navigation.

@)

e Analysis Tools
In the top right corner are the analysis tools. The tools on this toolbar allow users to

@)
identify, select and query features, and load subsets.

e Navigation Tools
In the bottom left corner is the navigation wheel. It provides map navigation

(@]
functionality such as zoom to full extent, rotate, zoom in/out.

Notes:

Lucity GIS Viewer Overview (2015 and 2015r2)



Map Management Toolbar
The following are the various tools available on the map management toolbar:

@IHEIA S

@ Log

Errors encountered using the various GIS Viewer tools will typically be logged. In addition, some tools
may log additional information why it was unable to complete the requested task. Click on this tool to
bring up a list of items that have been logged.

| Log [ X |

10:38 AM Failed to cpen desktop application. Failure Code = NoFailure

——
()

Each item will contain a time stamp of when it was recorded. Use the copy button to copy the
contents to the clipboard. Closing out of the Lucity GIS Viewer will clear the log.

M“:if' Map Layers
This tool allows users to toggle feature layer visibility, transparency, selectability along with the ability
to remove a layer from the map.

e [Remove Map Service- click this to
remove the map service and all associated

X

.. Map Service Control
feature classes. This is only for the current Remove Map (3] Demo 0 Service
|51 Lucitysis.pBo.FoGFacilty Transparency

loaded, the map service will be back.

map session. The next time the map is Service ‘
Feature Class

. LI Transparency- this controls the -Sergegiteabilit 2 |81 storm strucure
layer transparency. Move the horizontal | -
scroll to adjust the level of transparency. ‘ < /|8 )] Storm Condit
Symbology
|@ . . V] Sewer
. Selectability- this controls whether or [ e
not the layer is selectable. When R e
disabled, the layer will not be included in Display/Hide 'J—Jﬁdw
results when using the identify, select, or i
query tools. (B Parces

o IilVisibility- this controls whether or not
the layer is visible in the map.

Note: All these settings are just for the current map session. The will be set to the default
values the next time the map is loaded.

Lucity GIS Viewer Overview (2015 and 2015r2) 18



+
~J Add Data
This tool can be used to add data to the map. Map and Tile packages along with map or tile web

services can be added on the fly.

Lucity GIS- Add map service or package to map ﬁ
Select Data Type:
1. Select the type of data to add from the drop down.
Map Package
Tile Package

Web Service- Tile
Web Service- Dynamic

2. Enter the location of the data source.
e If adding a map/tile package click the [— button to find the location of an .mpk or .tpk file.
If adding a web service, simply enter the URL of the service in the next box

Click Ok and the data will be added to the map. You can remove or adjust the layer properties
using the Map Layers tool.

I@ Data Table

The data table tool allows users to see information about and interact with features that are currently
selected or plotted in the map. This table is opened automatically by the use of some of the GIS

3.

Viewer tools.
Table Display Controls e &)X

Sanitary Sewer Services ” Sanitary Pipe Inventory * | Parks " |

OBJECTID
PORTLAND AVE

Selected :
Features 186 2959 2548 E KENT AVE Mull Null Riser

187 2960 2538 E | KENT | AVE | Mull MNull Riser -

=
< m | »
Receord: <<| < 1 Records (1 out of 94 Selected) | Options.. | === Feature Grid Controls

Table Display Controls
#: This button is used to expand the table to show more records

M This button is used to close the table. This does not clear the selection
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Tabs

At the top of the grid there is a row of tabs. Each tab corresponds to a feature class that has
features included in the current selection. Click on a tab to switch to a table showing the selected
features for that feature class.

Selected Features

Features that appear in the table are currently selected. They are displayed in the map using the
main selection color (the default is yellow).

e Click on one or more rows in the grid to highlight a subset of the selection results. These
features are displayed in the map using the secondary selection color (the default is red).

e The Lucity Tools work off the features that are selected in the grid.

Feature Grid Controls

EE| ~ EE' This button can be used to move through the records in the grid. It will
select/highlight the record number. It also displays the number of records in the grid

[ Op:t'ms'" | This button is shows various feature grid options.

o C(lear Selection- Clears the selected/highlighted features in

the grid Clear Selection
e Switch Selection- Features currently selected are 7 Switch Selection F
unselected and vice versa 5
Select &l .
o Select All- Selects/highlights all features in the grid H
. . Zoom Tao Selection 1
e Zoom to Selection- Zooms to the selected features in the g
grid. { Remaove Selected Row(s) -
e Remove Selected Row(s) - Removes the selected features 1 [ Auto Zoom to Selected I

from the grid. Note: This will also remove these features
from the map selection.

e Auto Zoom to Selected- Check this box if you wish the map display to zoom to each new
feature selected/highlighted in the grid.

Lucity Tools

These tools allow users to perform Lucity operations against features in the map. More information on
these tools can be found further in this document under the Lucity Tools section.

5:;'.1-

N\ Pan

This tool allows users to pan around in the map. This tool is selected by default when the map is first
loaded.

Lucity GIS Viewer Overview (2015 and 2015r2) 20



Q\ Q’\ Zoom In/Out

These tools allow the user to zoom in/out. Click the tool then draw a box to the extent you would like
to see displayed.

Note: If you have a mouse wheel, it can also be used to zoom in/out of the map display.

Return to Previous/Next Extent
These tools allow you to cycle through previous map extents.

Navigation Wheel

The following are the various navigation tools:

A. Pan - Click the four arrows on the wheel to move the map
North, South, East, and West.

N B. Rotate - Click and drag the other areas of the compass to
rotate the map in any direction.

-] C. Zoom to Full Extent - Click the globe icon on the lower right of
-+ the compass to zoom to the full extent.

D. Reset North - Click the arrow icon on the lower left of the
compass to reset the map to North.

E. Zoom In/Out - Click the + and - buttons on the left side of the
compass to zoom in and out of the map.

Notes:
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Analysis Toolbar
The following are the various tools available on the analysis toolbar:

6ﬁ 4 & :E

o Identify

The Identify tool allows users to select a feature in the map and display its attributes. Note: Only
layers marked as selectable in Map Properties will be displayed in the results.

1. Using the identify tool click a feature in the map. The identify results window will appear.

[12685? (Sanitary Structure Inventory) - fE
QBJECTID 305

Structure 126857

Subtype Nul

Structure Type Standard

Structure Depth (ft) 1258.12

Rim Elevation 1272.64

Status (NN

Component Type Standard

GPS Flag Nul

Unique Number 29982

In Lucity Database? 1

Last Modified By GBA

Last Modified date 7/24/2006 2:00:58 PM
Last Synchronized Date|12/9/2011

SHAPE Paint

2. If more than one feature was at the location of the mouse-click, you can use the drop down to
select the desired feature.

H Find

The Find tool searches for addresses and assets based upon the criteria the user enters. Note: Only
layers marked as selectable in Map Properties will be

displayed in the results.
) Address |Asset | Attribute Query | Customer |

Find Address P

1. To locate an address in the map enter and v
Address and Street. (Optional) Cross Street

2. Enter optional cross street or zip code (Optional) Zip Code
Click Find

4. A point will be put in the map at the address
location.
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Find Asset

1. To locate an asset in the map select a | Address | Asset | Attribute Query | Customer |
Feature Type. This list is populated with the Feature Type
feature classes linked to Lucity in the map. [ 'l

2. Typein an asset number. This is the
feature’s common identifier.

Click Find supports % for partial match

4. The asset(s) will be selected in the map.

Attribute Query

1. To select features in the map based upon an : x
attribute query, select a Layer. This list is
populated with all selectable layers in the map. [La:fer |

2. Select a Field. This list is populated with all the Field
fields from the layer. [ x|

3. Enter a Value. This is the value you want to Value

search for in the field.
4. Click Find.

The asset(s) that meet the search criteria will
be selected in the map.

supports % for partial match

; Create Point

This tool creates a point in the map. This tool can be used to add x/y locations to a work request,
work order, and pm/work template records.

1. Using the Create Point tool click a location in the map.

2. Ared point will appear in the map and the Data Table will be opened with a tab for X/Y Points.

&
[T Selection

This tool allows users to select features. Note: Only layers that are marked as selectable will be
included in the selection results.

(']
5" Clear Selection

This tool clears the map selection. All selected features in the map will be cleared and any address or
x/y points added to the map will also be removed.
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L | =
5B Load Subsets

The Load Subsets tool allows users to load a subset in the map. This tool can either select the features
that are included in the subset, or create a temporary subset layer that contains these features.

1. Click the Load Subset tool, the following dialog will appear:

Lucity GIS- Load a subset [ x|
Select Type of Subset:
[Parks vl
Select Subset:

‘Parks |
[] Load as a Subset Layer instead of a selection

2. Choose an asset type from the Select Type of Subset list. This list only includes asset types for
which there is a feature class in the map.

3. By default, the tool will select features in the layers in the map linked to the asset type
selected. Check the Load as Subset Layer box if you prefer to have a new layer added in the
map with the subset features.

4. Click OK

The assets will be selected in the map and appear in the Data Table or a layer will be added to
the map and you can modify its properties using the Map Layers tool.

Notes:
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Lucity Tools
The following are the various Lucity tools available in the Data Table

BIE]
Relationships

The Relationships tool shows all Lucity modules and records related to the highlighted record(s). Users
can then view the related record(s) in either the Lucity desktop or web application.

1. After making a selection in the map, select the desired record(s) in the data grid.

2. Select the Relationships tool. The following results window will appear:

w | & (0
2

Pipe Inventory

TV Inspection

Line Lamping

Smoke Testing

Rehab Pipe Analysis Details

Service Laterals
PACP Inspections

Sewer Construction

Pipe Air Testing

Pipe Mandrel Testing

Sewer Building Inspection
Work Crders
PM/Work Template

D|lo(laola|lo|lala|la|ln|lala|lo |

Work Requests

3. Each line in the window is a Lucity module. To the right of the module name is a count of how
many records in that module are related to the selected record(s) in the data grid.

4. Select a module to view, then click on one of the following buttons to open that module.
(i
=2 Open in Lucity Desktop
L
% Open in Lucity Web

Create Subset

The Create Subset tool allows users to create a new subset from selected features. Subsets allow users
to save a fixed group of records for later use.

1. After making a selection in the map, select the desired record(s) in the data grid.

2. In the Data Table, click the Create Subset tool. A dialog similar to the following will appear:
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Lucity GIS- Create a new subset [ x|

Enter a subset name

Sanitary Pipe Inventory 8/15/2012 3:54:36 PM

3. Enter a name for the subset. By default the dialog creates a name based on the asset type,
date, and time.
4. Click OK.

Once complete a dialog will appear indicating if it was successful.
Lucity GIS

Subset successfully created!

Add to Subset

The Add to Subset tool allows users to add assets to an existing subset.

1. After making a selection in the map, select the desired record(s) in the data grid.
2. In the Data Table, click the Add to Subset tool. A dialog similar to the following will appear.
Lucity GIS- Add to existing subset [ X |
Select Type of Subset:
[599}_@;\.’ Pipe Inventorny : V]
Select Subset:
Sanitary Pipe Inventory 8/15/2012 3:53:30 PM
Sanitary Pipe Inventory 8/15/2012 3:54:36 PM
test
3.

The type of subset will be automatically filled out based upon the asset type of the feature
class you are working with. Select an existing subset in the list provided.

4. Click OK

Once complete a dialog will appear indicating if it was successful
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Create Request

The Create Request tool allows users to create a request from the map based on an asset or x/y
location.

1. After making a selection in the map, select the desired record(s) in the data grid.
2. In the Data Table, click the Create Request tool.

3. If the highlighted asset does not have a default work category, the following popup will appear.
Only valid categories will appear in the list. Select a category and click OK.

Select a category for Sanitary Pipe Inventary [ x|

I+ 20000 Sewer Department
TST.SP SEWER PIPE
TST.5P2 SEWER PIPEZ
TST.5P-C SEWER PIPE For Cost

4. Once complete a dialog will appear indicating if you would like to edit the request in the web
or desktop application.

Lucity GIS L X

Request created successfully. Would you like to edit the request in the web or desktop application?

DCreate Work Order

The Create Work Order tool allows users to create a work order from the map based on asset(s) or x/y
location(s).

1. After making a selection in the map, select the desired record(s) in the data grid.
2. In the Data Table, click the Create Work Order tool.

3. If the highlighted asset does not have a default work category, the following popup will appear.
Only valid categories will appear in the list. Select a category and click OK.

Select a category for Sanitary Pipe Inventory [ x|

I+ 20000 Sewer Department
TST.SP SEWER PIPE
TST.5P2 SEWER PIPE2
TST.5P-C SEWER PIPE For Cost
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4. Once complete a dialog will appear indicating if you would like to edit the work order in the
web or desktop application.
-

Request created successfully. Would you like to edit the request in the web or desktop application?

Lucity GIS

E] Add to Work Order
The Add to Work Order tool allows users to add asset(s) or x/y location(s) to an existing work order

from the map.
1. After making a selection in the map, select the desired record(s) in the data grid.

2. In the Data Table, click the Add to Work Order tool. The following dialog will appear:

Lucity GIS [ X |
Enter the existing work order number.

3. Enter the existing work order number and click OK.

4. If the highlighted asset does not have a default work category, the following popup will appear.
Only valid categories will appear in the list. Select a category and click OK.

Select a category for Sanitary Pipe Inventory

I+ 20000 Sewer Department
TST.SP SEWER PIPE
TST.SP2 SEWER PIPE2Z
TST.SP-C SEWER PIPE For Cost

5. Once complete a dialog will appear indicating if you would like to edit the work order in the
web or desktop application.

Lucity GIS

Request created successfully. Would you like to adit the request in the web or desktop application?
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Create PM/Work Template
The Create PM/Work Template tool allows users to create a pm/work template record from the map

based on asset(s) or x/y location(s).
1. After making a selection in the map, select the desired record(s) in the data grid.
2. In the Data Table, click the Create PM/Work Template tool. The following dialog will appear:

Lucity GIS

Enter a new Routine/PM Work Template code and description:

3. Enter a unique code and description for the pm/work template. Click OK.

4. If the highlighted asset does not have a default work category, the following popup will appear.
Only valid categories will appear in the list. Select a category and click OK.

Select a category for Sanitary Pipe Inventory

I+ 20000 Sewer Department
TST.SP SEWER PIPE
TST.5P2 SEWER PIPE2
TST.5P-C SEWER PIPE For Cost

5. Once complete a dialog will appear indicating if you would like to edit the pm/work template
record in the web or desktop application.

Lucity GIS
PM/Weork Template record created successfully. Would you like to edit the record in the web or desktop

application?

Notes:
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B
Add to PM/Work Template
The Add to PM/Work Template tool allows users to add asset(s) or x/y location(s) to an existing

pm/work template record from the map.
1. After making a selection in the map, select the desired record(s) in the data grid.

2. In the Data Table, click the Add to PM/Work Template tool. The following dialog will appear:
| X

Lucity GIS

Enter the existing PM/Work Template number.

|

3. Enter the existing pm/work template number and click OK.

4. If the highlighted asset does not have a default work category, the following popup will appear.

Only valid categories will appear in the list. Select a category and click OK.
B

Select a category for Sanitary Pipe Inventory

I+ 20000 Sewer Department
TST.SP SEWER PIPE
TST.5P2 SEWER PIPE2
TST.5P-C SEWER PIPE For Cost

5. Once complete a dialog will appear indicating if you would like to edit the pm/work template
in the web or desktop application.

Lucity GIS [ X |
PM/Work Temnplate record created successfully. Would you like to edit the record in the web or desktap
application?
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